About this Course...

This course is designed for people who work in longer and more complex documents than the standard letters and other short documents that Microsoft Word is often used to produce. Typically anyone involved in writing, creating, editing or formatting Report, Thesis, Tender, Contract and Manual or any other long document would be an ideal candidate to attend this course.

Please note that this course is not intended for novice users of Microsoft Word. Attendees should already have Intermediate or Advanced skills in Microsoft Word.

Chapters in the Workbook...

Chapter 1 – Section Breaks
Chapter 2 – Styles, Macros, Tables & Templates
Chapter 3 – Master Documents

What you Will Need...

In order to complete the exercises in this workbook, the following is required...

- A desktop computer (or laptop) running Microsoft Windows 2000, XP or Vista (or later).
- A set of Mobile MOUSe Practice Files.
# Table of Contents

## Chapter 1 - Section Breaks

1.1 Section Breaks Explained .................................................................................. 1  
1.1.1 Inserting and Deleting Section Breaks ....................................................... 1  
1.1.2 Show / Hide Symbols (Formatting Marks) .................................................. 4  

## Chapter 2 - Styles, Macros, Tables & Templates

2.1 The Power of Styles .......................................................................................... 12  
2.2 Using Quick Styles ......................................................................................... 13  
2.3 Changing the Style Set ................................................................................... 15  
2.4 Creating and Applying Styles .......................................................................... 17  
2.4.1 Creating a style for Body Text ................................................................. 17  
2.4.2 Box Selections ......................................................................................... 21  
2.4.3 List Styles for Numbering ....................................................................... 22  
2.4.4 Modifying a Style .................................................................................... 28  
2.4.5 Heading Numbering ................................................................................ 29  
2.4.6 Character Styles ..................................................................................... 34  
2.4.7 Paste Options ......................................................................................... 36  
2.4.8 Table Styles ........................................................................................... 41  
2.5 Working with Tables ...................................................................................... 44  
2.5.1 Importing Data from Excel ....................................................................... 44  
2.5.2 Sorting Data within a Table ..................................................................... 48  
2.5.3 Performing Calculations in Word Tables ................................................. 51  
2.5.4 Editing Formulas .................................................................................... 53  
2.5.5 Accessing Additional Functions ............................................................... 53  
2.5.6 Recalculating Word Formulas ................................................................. 53  
2.6 Preparing the Document to Become a Template ........................................... 54  
2.6.1 Setup Headers and Page Numbering ....................................................... 54  
2.6.2 Using the STYLEREF Field .................................................................... 55  
2.6.3 Showing or Hiding Styles ..................................................................... 57  
2.7 Building a Table of Contents ......................................................................... 60  
2.8 Captioning ..................................................................................................... 66  
2.9 Building a Table of Figures / Tables ............................................................... 67  
2.10 Building Other Reference Tables ................................................................. 71  
2.10.1 Creating a Table of Authorities ............................................................. 71  
2.10.2 Creating an Index .................................................................................. 72  
2.11 Templates ..................................................................................................... 76  
2.11.1 Creating a Template ............................................................................. 77  
2.11.2 Creating a New document from an Existing Template ....................... 78  
2.11.3 Opening a Template for Editing ............................................................. 78  
2.12 Modifying the Template ............................................................................... 79  
2.13 Macros .......................................................................................................... 81  
2.13.1 Customizing Word with Macros ........................................................... 81  
2.13.2 Recording Macros ............................................................................... 81  
2.13.3 Creating a Custom button to Run a Macro .......................................... 88  
2.13.4 Macro Security Settings ....................................................................... 91  
2.13.5 Editing Macro Code ............................................................................ 92  
2.13.6 Deleting Macros ................................................................................. 95  
2.13.7 Editing Macro Code ............................................................................ 92  
2.14 Protecting the Styles and Formatting in a Document or Template ............... 96  
2.14.1 Applying Protection for your Styles and Formats ............................... 96  
2.15 Transferring Styles / Macros and Toolbars between Documents ................ 100
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.15.1 Transferring Styles with Quick Style Sets</td>
<td>100</td>
</tr>
<tr>
<td>2.15.2 Attaching a Template to an Existing Document</td>
<td>102</td>
</tr>
<tr>
<td>2.15.3 Add / Modify Styles to an Existing Template</td>
<td>105</td>
</tr>
<tr>
<td>2.15.4 Use the Organizer to Transfer Objects between Documents or Templates</td>
<td>106</td>
</tr>
</tbody>
</table>

## Chapter 3 - Master Documents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Master and Subdocuments</td>
<td>109</td>
</tr>
<tr>
<td>3.1.1 The Concept of Master and Subdocuments</td>
<td>109</td>
</tr>
<tr>
<td>3.1.2 Rules for Master Documents and Subdocuments</td>
<td>110</td>
</tr>
<tr>
<td>3.1.3 Specific Rules for the Master Document</td>
<td>110</td>
</tr>
<tr>
<td>3.1.4 The Importance of Styles and Templates</td>
<td>111</td>
</tr>
<tr>
<td>3.1.5 Subdocuments</td>
<td>111</td>
</tr>
<tr>
<td>3.1.6 The Master Document</td>
<td>113</td>
</tr>
<tr>
<td>3.1.7 Removing a Subdocument</td>
<td>114</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2 Moving Around Large Documents</td>
<td>116</td>
</tr>
<tr>
<td>3.2.1 The Browse Object Menu</td>
<td>116</td>
</tr>
<tr>
<td>3.2.2 Use the Document Map Effectively</td>
<td>117</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3 Cross Referencing / Footnotes / Endnotes</td>
<td>120</td>
</tr>
<tr>
<td>3.3.1 Creating Cross-References</td>
<td>120</td>
</tr>
<tr>
<td>3.3.2 Annotating with Endnotes and Footnotes</td>
<td>123</td>
</tr>
</tbody>
</table>
## 1 How to Use this Manual

<table>
<thead>
<tr>
<th>When you see this...</th>
<th>It means...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="IMPORTANT NOTE(S)" /></td>
<td>You <strong>MUST</strong> read this, because it could have an effect on the final outcome of an action you perform.</td>
</tr>
<tr>
<td><img src="image" alt="HOT TIP(S) &amp; IDEA(S)" /></td>
<td>This is optional to read, but these tips often point out quicker ways of doing things, or alternative methods.</td>
</tr>
<tr>
<td><img src="image" alt="TIME TO EXERCISE..." /></td>
<td>You are about to start an exercise in the workbook.</td>
</tr>
</tbody>
</table>

**Bold Text in Exercises**

Objects that you click on, like buttons, tabs or menus are often listed in **Bold**. Locations and folders are also listed in **Bold**.

**Super Shake**

When you see text like this it means you should type the text.

Keyboard shortcuts are displayed like this. In this example you would press and hold **CTRL**, hold **SHIFT** and then press **ESC** once (while still holding **CTRL** and **SHIFT**).

**Edit > Copy**

Click the **Edit** menu, click **Copy**

“This is a paragraph...”

This is existing typed text in a document you are currently working on.

### Download and Install the Exercise Files

In addition to the exercises you will complete in class, there are also exercises in this workbook. These workbook exercises can only be completed in conjunction with your practice files. In order to locate your exercise files visit: [www.mobilemouse.com.au/downloads.php](http://www.mobilemouse.com.au/downloads.php).

**To install the practice files perform the following steps...**

1. **Start Internet Explorer**, click in the **Address Bar** and type the following address: `http://www.mobilemouse.com.au/downloads.php` and then press **ENTER**
2. **Scroll down the page and click the link**: Microsoft Word practice files (all Word)
3. **At the screen that appears, click the Save button**
4. At the **Save As** dialog box, click the **Desktop** link on the left hand side of the screen, click **Save**

5. Depending on your internet connection, the time it takes to download the practice files may vary. Once the download completes, close any open programs.

6. On your **Windows Desktop** you should see **Mobile MOUSe – Word Practice Files.exe** (or **Mobile MOUSe – Word Practice Files**). Double click this file to start the installation process; you may be presented with the following screen...
7. If presented with the above image, click the Run button, which will present the following screen...

8. Click Next

9. Click Next, which takes you to the following screen...
Download and Install the Exercise Files

10. At this screen, you would typically choose **Next**. This will install the practice files onto your **Windows Desktop** (the location referred to in the exercises in this manual). You can however choose a different location if you like, however we would recommend that you click **Next**... (so click **Next**)

11. Click **Next** to install the files

12. At the final screen click **Finish** to complete the installation. Your practice files are now installed and you can commence the exercises in this manual
Chapter 1 - Section Breaks

This chapter covers the following concepts...

- Section Breaks
- Sectioned Page Numbering
- Applying Different Headers and Footers to different sections

1.1 Section Breaks Explained

Word uses sections to organize or “split” documents for formatting purposes. A section is a continuous portion of a document that has a specified number of columns and uses a common set of margins, page orientation, header and footer settings and page numbering. You can manually insert a section break to apply a different paper size, page orientation or even different headers and footers between different areas of a document.

As an example, should you want the first two pages of your document (the cover page and the contents page) to have no headers and footers (and no page numbering) and you would then like the headers and footers to start on the third page and have the page numbering start at 1 (on page three), you would need to utilise section breaks.

Word will automatically insert section breaks (Continuous) when you do either of the following:

- Format text into Columns.
- Change Page Setup options and indicate that you want the changes to apply from This Point Forward.

1.1.1 Inserting and Deleting Section Breaks

In the following exercise, you will create section breaks and change the page orientation for the various sections of the document.

TIME TO EXERCISE...

> INSERTING AND DELETING SECTION BREAKS

1. Open the file entitled: Letter - June2004.docx (in the Desktop \ Word \ Complex Documents folder)
2. Position the cursor where you want the break to begin, for this exercise, press Ctrl + End
3. Click the Page Layout tab, choose Breaks

You are then presented will the following choices...

QUICK NOTES
Figure 1-1: Break Types in Microsoft Word

In the Section Breaks area, you can select one of the following section break options:

- **Next Page**: Inserts a section break and starts the new section at the beginning of the next page. You might use this type of break when you want to change page orientation.
- **Continuous**: Inserts a section break without inserting a page break. Any subsequent text you type directly follows the existing text. This break works well when you want to change the number of columns.
- **Even Page**: Inserts a section break and starts the new section at the beginning of the next even-numbered page in the document. If the section break is inserted on an even-numbered page, word leaves the intervening page (an odd-numbered page) blank.
- **Odd Page**: Inserts a section break and starts the new section at the beginning of the next odd-numbered page in the document. If the section break is inserted on an odd-numbered page, Word leaves the intervening page (an even-numbered page) blank.

4. Click **Next Page**, to insert the section break and start a new page

In the bottom left hand corner of the status bar, you should notice the words **Sec 2**